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Legal Notices

Extreme Networks, Inc., on behalf of or through its wholly-owned subsidiary, Enterasys
Networks, Inc., reserves the right to make changes in specifications and other information
contained in this document and its website without prior notice. The reader should in all cases
consult representatives of Extreme Networks to determine whether any such changes have
been made.

The hardware, firmware, software or any specifications describbed or referred to in this
document are subject to change without notice.

Trademarks

Extreme Networks and the Extreme Networks logo are trademarks or registered trademarks of
Extreme Networks, Inc. in the United States and/or other countries.

All other names (including any product names) mentioned in this document are the property of
their respective owners and may be trademarks or registered trademarks of their respective
companies/owners.

For additional information on Extreme Networks trademarks, please see:
www.extremenetworks.com/company/legal/trademarks/

Contact
If you require assistance, contact Extreme Networks using one of the following methods.

* Global Technical Assistance Center (GTAC) for Immediate Support

¢ Phone: 1-800-998-2408 (toll-free in U.S. and Canada) or 1-603-952-5000. For the Extreme
Networks support phone number in your country, visit:
www.extremenetworks.com/support/contact

e Email: support@extremenetworks.com. To expedite your message, enter the product name or
model number in the subject line.

¢ GTAC Knowledge — Get on-demand and tested resolutions from the GTAC Knowledgebase, or create a
help case if you need more guidance.

¢ The Hub — A forum for Extreme customers to connect with one another, get questions answered, share
ideas and feedback, and get problems solved. This community is monitored by Extreme Networks
employees, but is not intended to replace specific guidance from GTAC.

e Support Portal — Manage cases, downloads, service contracts, product licensing, and training and
certifications.
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Extreme Networks Software License Agreement

This Extreme Networks Software License Agreement is an agreement ("Agreement") between You, the end user,
and Extreme Networks, Inc. ("Extreme"), on behalf of itself and its Affiliates (as hereinafter defined and including its
wholly owned subsidiary, Enterasys Networks, Inc. as well as its other subsidiaries). This Agreement sets forth Your
rights and obligations with respect to the Licensed Software and Licensed Materials. BY INSTALLING THE
LICENSE KEY FOR THE SOFTWARE ("License Key"), COPYING, OR OTHERWISE USING THE LICENSED
SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES THE
LICENSE AND THE LIMITATION OF WARRANTY AND DISCLAIMER OF LIABILITY. IF YOU DO NOT AGREE TO
THE TERMS OF THIS AGREEMENT, RETURN THE LICENSE KEY TO EXTREME OR YOUR DEALER, IF ANY, OR DO
NOT USE THE LICENSED SOFTWARE AND CONTACT EXTREME OR YOUR DEALER WITHIN TEN (10) DAYS
FOLLOWING THE DATE OF RECEIPT FOR A REFUND. IF YOU HAVE ANY QUESTIONS ABOUT THIS
AGREEMENT, CONTACT EXTREME, Attn: LegalTeam@extremenetworks.com.

1.

2.

4,

DEFINITIONS. "Affiliates” means any person, partnership, corporation, limited liability company, or other form of enterprise that
directly or indirectly through one or more intermediaries, controls, or is controlled by, or is under common control with the party
specified. "Server Application” shall refer to the License Key for software installed on one or more of Your servers. "Client
Application” shall refer to the application to access the Server Application. "Licensed Materials” shall collectively refer to the
licensed software (including the Server Application and Client Application), Firmware, media embodying the software, and the
documentation. "Concurrent User" shall refer to any of Your individual employees who You provide access to the Server
Application at any one time. "Firmware" refers to any software program or code imbedded in chips or other media. "Licensed
Software" refers to the Software and Firmware collectively.

TERM. This Agreement is effective from the date on which You install the License Key, use the Licensed Software, or a Concurrent
User accesses the Server Application. You may terminate the Agreement at any time by destroying the Licensed Materials,
together with all copies, modifications and merged portions in any form. The Agreement and Your license to use the Licensed
Materials will also terminate if You fail to comply with any term of condition herein.

GRANT OF SOFTWARE LICENSE. Extreme will grant You a non-transferable, non-exclusive license to use the machine-readable
form of the Licensed Software and the accompanying documentation if You agree to the terms and conditions of this Agreement.
You may install and use the Licensed Software as permitted by the license type purchased as described below in License Types.
The license type purchased is specified on the invoice issued to You by Extreme or Your dealer, if any. YOU MAY NOT USE, COPY,
OR MODIFY THE LICENSED MATERIALS, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

LICENSE TYPES.

» Single User, Single Computer. Under the terms of the Single User, Single Computer license, the license granted to You by
Extreme when You install the License Key authorizes You to use the Licensed Software on any one, single computer only, or
any replacement for that computer, for internal use only. A separate license, under a separate Software License Agreement,




is required for any other computer on which You or another individual or employee intend to use the Licensed Software. A
separate license under a separate Software License Agreement is also required if You wish to use a Client license (as
described below).

e (Client. Under the terms of the Client license, the license granted to You by Extreme will authorize You to install the License
Key for the Licensed Software on your server and allow the specific number of Concurrent Users shown on the relevant
invoice issued to You for each Concurrent User that You order from Extreme or Your dealer, if any, to access the Server
Application. A separate license is required for each additional Concurrent User.

5. AUDIT RIGHTS. You agree that Extreme may audit Your use of the Licensed Materials for compliance with these terms and Your
License Type at any time, upon reasonable notice. In the event that such audit reveals any use of the Licensed Materials by You
other than in full compliance with the license granted and the terms of this Agreement, You shall reimburse Extreme for all
reasonable expenses related to such audit in addition to any other liabilities You may incur as a result of such non-compliance,
including but not limited to additional fees for Concurrent Users over and above those specifically granted to You. From time to
time, the Licensed Software will upload information about the Licensed Software and the associated devices to Extreme. This is to
verify the Licensed Software is being used with a valid license. By using the Licensed Software, you consent to the transmission of
this information. Under no circumstances, however, would Extreme employ any such measure to interfere with your normal and
permitted operation of the Products, even in the event of a contractual dispute.

6. RESTRICTION AGAINST COPYING OR MODIFYING LICENSED MATERIALS. Except as expressly permitted in this Agreement, You
may not copy or otherwise reproduce the Licensed Materials. In no event does the limited copying or reproduction permitted
under this Agreement include the right to decompile, disassemble, electronically transfer, or reverse engineer the Licensed
Software, or to translate the Licensed Software into another computer language.

The media embodying the Licensed Software may be copied by You, in whole or in part, into printed or machine readable form,
in sufficient numbers only for backup or archival purposes, or to replace a worn or defective copy. However, You agree not to
have more than two (2) copies of the Licensed Software in whole or in part, including the original media, in your possession for
said purposes without Extreme’s prior written consent, and in no event shall You operate more copies of the Licensed Software
than the specific licenses granted to You. You may not copy or reproduce the documentation. You agree to maintain appropriate
records of the location of the original media and all copies of the Licensed Software, in whole or in part, made by You. You may
modify the machine-readable form of the Licensed Software for (1) your own internal use or (2) to merge the Licensed Software
into other program material to form a modular work for your own use, provided that such work remains modular, but on
termination of this Agreement, You are required to completely remove the Licensed Software from any such modular work. Any
portion of the Licensed Software included in any such modular work shall be used only on a single computer for internal purposes
and shall remain subject to all the terms and conditions of this Agreement. You agree to include any copyright or other proprietary
notice set forth on the label of the media embodying the Licensed Software on any copy of the Licensed Software in any form, in
whole or in part, or on any modification of the Licensed Software or any such modular work containing the Licensed Software or
any part thereof.

7. TITLE AND PROPRIETARY RIGHTS

a. The Licensed Materials are copyrighted works and are the sole and exclusive property of Extreme, any company or a division
thereof which Extreme controls or is controlled by, or which may result from the merger or consolidation with Extreme (its
" Affiliates™), and/or their suppliers. This Agreement conveys a limited right to operate the Licensed Materials and shall not be
construed to convey title to the Licensed Materials to You. There are no implied rights. You shall not sell, lease, transfer,
sublicense, dispose of, or otherwise make available the Licensed Materials or any portion thereof, to any other party.

b. You further acknowledge that in the event of a breach of this Agreement, Extreme shall suffer severe and irreparable
damages for which monetary compensation alone will be inadequate. You therefore agree that in the event of a breach of
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this Agreement, Extreme shall be entitled to monetary damages and its reasonable attorney’s fees and costs in enforcing this
Agreement, as well as injunctive relief to restrain such breach, in addition to any other remedies available to Extreme.

PROTECTION AND SECURITY. In the performance of this Agreement or in contemplation thereof, You and your employees and

agents may have access to private or confidential information owned or controlled by Extreme relating to the Licensed Materials
supplied hereunder including, but not limited to, product specifications and schematics, and such information may contain
proprietary details and disclosures. All information and data so acquired by You or your employees or agents under this
Agreement or in contemplation hereof shall be and shall remain Extreme’s exclusive property, and You shall use your best efforts
(which in any event shall not be less than the efforts You take to ensure the confidentiality of your own proprietary and other
confidential information) to keep, and have your employees and agents keep, any and all such information and data confidential,
and shall not copy, publish, or disclose it to others, without Extreme’s prior written approval, and shall return such information and
data to Extreme at its request. Nothing herein shall limit your use or dissemination of information not actually derived from
Extreme or of information which has been or subsequently is made public by Extreme, or a third party having authority to do so.
You agree not to deliver or otherwise make available the Licensed Materials or any part thereof, including without limitation the
object or source code (if provided) of the Licensed Software, to any party other than Extreme or its employees, except for
purposes specifically related to your use of the Licensed Software on a single computer as expressly provided in this Agreement,
without the prior written consent of Extreme. You agree to use your best efforts and take all reasonable steps to safeguard the
Licensed Materials to ensure that no unauthorized personnel shall have access thereto and that no unauthorized copy, publication,
disclosure, or distribution, in whole or in part, in any form shall be made, and You agree to notify Extreme of any unauthorized use
thereof. You acknowledge that the Licensed Materials contain valuable confidential information and trade secrets, and that
unauthorized use, copying and/or disclosure thereof are harmful to Extreme or its Affiliates and/or its/their software suppliers.

MAINTENANCE AND UPDATES. Updates and certain maintenance and support services, if any, shall be provided to You pursuant

to the terms of an Extreme Service and Maintenance Agreement, if Extreme and You enter into such an agreement. Except as
specifically set forth in such agreement, Extreme shall not be under any obligation to provide Software Updates, modifications, or
enhancements, or Software maintenance and support services to You.

DEFAULT AND TERMINATION. In the event that You shall fail to keep, observe, or perform any obligation under this Agreement,

including a failure to pay any sums due to Extreme, or in the event that you become insolvent or seek protection, voluntarily or
involuntarily, under any bankruptcy law, Extreme may, in addition to any other remedies it may have under law, terminate the
License and any other agreements between Extreme and You.

a. Immediately after any termination of the Agreement or if You have for any reason discontinued use of Software, You shall
return to Extreme the original and any copies of the Licensed Materials and remove the Licensed Software from any modular
works made pursuant to Section 3, and certify in writing that through your best efforts and to the best of your knowledge the
original and all copies of the terminated or discontinued Licensed Materials have been returned to Extreme.

b. Sections1,7,8,10,11,12,13,14 and 15 shall survive termination of this Agreement for any reason.

EXPORT REQUIREMENTS. You are advised that the Software is of United States origin and subject to United States Export

Administration Regulations; diversion contrary to United States law and regulation is prohibited. You agree not to directly or
indirectly export, import or transmit the Software to any country, end user or for any Use that is prohibited by applicable United
States regulation or statute (including but not limited to those countries embargoed from time to time by the United States
government); or contrary to the laws or regulations of any other governmental entity that has jurisdiction over such export,
import, transmission or Use.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS. The Licensed Materials (i) were developed solely at private expense; (ii)

contain "restricted computer software” submitted with restricted rights in accordance with section 52.227-19 (a) through (d) of the
Commercial Computer Software-Restricted Rights Clause and its successors, and (iii) in all respects is proprietary data belonging
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to Extreme and/or its suppliers. For Department of Defense units, the Licensed Materials are considered commercial computer
software in accordance with DFARS section 227.7202-3 and its successors, and use, duplication, or disclosure by the U.S.
Government is subject to restrictions set forth herein.

LIMITED WARRANTY AND LIMITATION OF LIABILITY. The only warranty that Extreme makes to You in connection with this
license of the Licensed Materials is that if the media on which the Licensed Software is recorded is defective, it will be replaced
without charge, if Extreme in good faith determines that the media and proof of payment of the license fee are returned to
Extreme or the dealer from whom it was obtained within ninety (90) days of the date of payment of the license fee.

NEITHER EXTREME NOR ITS AFFILIATES MAKE ANY OTHER WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, WITH
RESPECT TO THE LICENSED MATERIALS, WHICH ARE LICENSED "AS IS". THE LIMITED WARRANTY AND REMEDY PROVIDED
ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE, WHICH ARE EXPRESSLY DISCLAIMED, AND STATEMENTS OR REPRESENTATIONS
MADE BY ANY OTHER PERSON OR FIRM ARE VOID. ONLY TO THE EXTENT SUCH EXCLUSION OF ANY IMPLIED WARRANTY IS
NOT PERMITTED BY LAW, THE DURATION OF SUCH IMPLIED WARRANTY IS LIMITED TO THE DURATION OF THE LIMITED
WARRANTY SET FORTH ABOVE. YOU ASSUME ALL RISK AS TO THE QUALITY, FUNCTION AND PERFORMANCE OF THE
LICENSED MATERIALS. INNO EVENT WILL EXTREME OR ANY OTHER PARTY WHO HAS BEEN INVOLVED IN THE CREATION,
PRODUCTION OR DELIVERY OF THE LICENSED MATERIALS BE LIABLE FOR SPECIAL, DIRECT, INDIRECT, RELIANCE,
INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING LOSS OF DATA OR PROFITS OR FOR INABILITY TO USE THE
LICENSED MATERIALS, TO ANY PARTY EVEN IF EXTREME OR SUCH OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. IN NO EVENT SHALL EXTREME OR SUCH OTHER PARTY'S LIABILITY FOR ANY DAMAGES ORLOSS TO
YOU OR ANY OTHER PARTY EXCEED THE LICENSE FEE YOU PAID FOR THE LICENSED MATERIALS.

Some states do not allow limitations on how long an implied warranty lasts and some states do not allow the exclusion or
limitation of incidental or consequential damages, so the above limitation and exclusion may not apply to You. This limited
warranty gives You specific legal rights, and You may also have other rights which vary from state to state.

JURISDICTION. The rights and obligations of the parties to this Agreement shall be governed and construed in accordance with
the laws and in the State and Federal courts of the State of California, without regard to its rules with respect to choice of law. You
waive any objections to the personal jurisdiction and venue of such courts. None of the 1980 United Nations Convention on the
Limitation Period in the International Sale of Goods, and the Uniform Computer Information Transactions Act shall apply to this
Agreement.

GENERAL.

a. This Agreement is the entire agreement between Extreme and You regarding the Licensed Materials, and all prior
agreements, representations, statements, and undertakings, oral or written, are hereby expressly superseded and canceled.

b. This Agreement may not be changed or amended except in writing signed by both parties hereto.
¢. Yourepresent that You have full right and/or authorization to enter into this Agreement.

d. This Agreement shall not be assignable by You without the express written consent of Extreme. The rights of Extreme and
Your obligations under this Agreement shall inure to the benefit of Extreme’s assignees, licensors, and licensees.

e. Section headings are for convenience only and shall not be considered in the interpretation of this Agreement.

f. The provisions of the Agreement are severable and if any one or more of the provisions hereof are judicially determined to be
illegal or otherwise unenforceable, in whole or in part, the remaining provisions of this Agreement shall nevertheless be
binding on and enforceable by and between the parties hereto.

g. Extreme’s waiver of any right shall not constitute waiver of that right in future. This Agreement constitutes the entire
understanding between the parties with respect to the subject matter hereof, and all prior agreements, representations,



statements and undertakings, oral or written, are hereby expressly superseded and canceled. No purchase order shall
supersede this Agreement.

. Should You have any questions regarding this Agreement, You may contact Extreme at the address set forth below. Any
notice or other communication to be sent to Extreme must be mailed by certified mail to the following address:

Extreme Networks, Inc.

145 Rio Robles

San Jose, CA 95134 United States
ATTN: General Counsel
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ExtremeCloud IQ - Site Engine Suite Installation

This document provides instructions for installing and launching ExtremeCloud 1Q - Site Engine,
and for launching ExtremeCloud 1Q - Site Engine applications on remote ExtremeCloud |Q - Site
Engine clients. It also includes information for those upgrading from an earlier version of
Extreme Management Center.

IMPORTANT: Backup the Extreme Management Center database prior to performing the upgrade and
save it to a safe location. Use the Administration > Backup/Restore tab.

General Information

Before you install ExtremeCloud 1Q - Site Engine, read the ExtremeCloud |Q - Site Engine
Release Notes. The most recent version of these release notes can be found at the
ExtremeCloud IQ - Site Engine Documentation site. Select Release Notes at the top of the page.

NOTE: The terms engine, gateway, and appliance are used interchangeably throughout ExtremeCloud I1Q -
Site Engine documentation.

Operating System Requirements

ExtremeCloud 1Q - Site Engine Server Requirements

These are the operating system requirements for the ExtremeCloud |IQ - Site Engine server.

Manufacturer Operating System

Linux Red Hat Enterprise Linux WS and ES v6 and v7
Ubuntu 18.04

VMware® (ExtremeCloud 1Q - Site Engine Virtual Engine) VMware ESXi™ 6.0 server
VMware ESXi™ 6.5 server
VMware ESXi™ 6.7 server
VMware ESXi™ 7.0 server
vSphere (client only)™

Microsoft” Hyper-V (ExtremeCloud IQ - Site Engine Virtual Engine) Windows' Server 2012 R2
Windows~ Server 2016

ExtremeCloud |IQ - Site Engine Client Requirements

These are the operating system requirements for remote ExtremeCloud IQ - Site Engine client
machines.
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General Information

Manufacturer

Operating System

Windows (qualified on the English version of the operating systems)

Windows™ 10

Linux Red Hat Enterprise Linux WS and ES v6 and v7
Ubuntu 18.04

Mac 05 X° El Capitan
Sierra

ExtremeCloud IQ - Site Engine Server and Client Hardware

Requirements

These are the hardware requirements for the ExtremeCloud 1Q - Site Engine server and
ExtremeCloud IQ - Site Engine client machines:

ExtremeCloud |IQ - Site Engine Server

Small Medium Enterprise Large Enterprise
Total CPUs 1 2 2 2
Total CPU Cores 8 16 24 24
Memory 16 GB 32GB 64 GB 64 GB
Disk Size 240 GB 480 GB 960 GB 192 7TB
IOPS 200 200 10,000 10,000
Recommended scale based on server configuration:
Maximum APs 250 2,500 25,000 25,000
Maximum Wireless 2,500 25,000 100,000 100,000
MUs
Maximum Managed 100 1,000 10,000 air gap 10,000 air gap
Devices 8,000 connected 8,000 connected
ExtremeControl End- N/A 50,000 200,000 200,000
Systems
Statistics Retention 90 180 180 360
(Days)
ExtremeAnalytics No Yes Yes Yes
MU Events No Yes Yes Yes

ExtremeCloud |IQ - Site Engine Client

Requirements

CPU Speed 3.0 GHz Dual Core Processor
Memory 8 GB (4 GB for 32-bit OS)
Disk Size 300 MB (User's home directory requires 50 MB for file storage)

Java Runtime Environment (JRE) (Oracle Java only)

Version 8

Browser! (Enable JavaScript and Cookies)

Microsoft Edge
Mozilla Firefox
Google Chrome
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General Information

IBrowsers set to a zoom ratio of less than 100% might not display ExtremeCloud IQ - Site Engine
properly (for example, missing borders around windows). Setting your browser to a zoom ratio
of 100% corrects this issue.

2When accessing ExtremeCloud 1Q - Site Engine using Firefox version 59.0.1 on a non-
touchscreen system on which a Windows operating system is installed, the vertical scroll arrows
do not display.

ExtremeControl Engine Version Requirements

For complete information on ExtremeControl engine version requirements, see Important
Upgrade Information.

Screen Resolution

For optimum display of ExtremeCloud 1Q - Site Engine windows and tables, the recommended
minimum screen resolution setting for ExtremeCloud |Q - Site Engine clients is 1024 by 768
pixels. For optimum display of graphs and tables, the recommended minimum screen resolution
setting is 1280 by 1024 pixels.

ExtremeCloud I1Q - Site Engine Services

During the ExtremeCloud IQ - Site Engine installation, you can enable the ExtremeCloud 1Q -
Site Engine Services, allowing it to run in the background on the ExtremeCloud 1Q - Site Engine
server. The service starts automatically by default, and if you shut down and restart the
machine, the service is restarted automatically.

You can also restart the services manually or disable a service so it does not start automatically
when you restart the server.

¢ SNMPTrap Service - Enables SNMP trap messages to be received and logged when problems or
irregularities are detected on network devices. Only one trap service may be running at atime on a
server. If you are also running a network management system on the server, you may wish to use the
network management trap service.

¢ TFTP - Enables you to upload and download configuration files, and download firmware to devices. Only
one TFTP service may be running at a time on a machine.

NOTE: The ExtremeCloud IQ - Site Engine TFTP Service does not support IPv6.

Typically, the TFTP service that exists in Linux is disabled; however, if it is enabled, you may wish to
disable it and enable the ExtremeCloud 1Q - Site Engine version of TETP which provides additional
features for ExtremeCloud IQ - Site Engine. If you elect to enable the ExtremeCloud 1Q - Site Engine
version on the Linux platform, you must first disable the Linux TFTP service and perform some
configuration as follows:

1. Using a text editor, edit the file /etc/xinetd.d/tftp

2. Setdisable = yes
Sample file:
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General Information

service tftp
REUSE

{ flags =
socket type =

wait
user

= no

= root
/usr/sbin/in.tftp

server =
disable =

}

yes

stream

3. Thenrun: /etc/rc3.d/S56xinetd restart

ExtremeCloud IQ - Site Engine version 23.04.11 supports upgrades from Extreme Management
Center 8.5.7 or ExtremeCloud 1Q - Site Engine. The following table details which upgrades are
needed for each NetSight, Extreme Management Center or ExtremeCloud 1Q - Site Engine
version prior to upgrading to ExtremeCloud |Q - Site Engine version 23.04.11.

NOTE:

You can change deployment modes from air gap to connected or from connected to air gap
after the upgrade.

Current Version

Upgrade to
ExtremeCloud 1Q -
Site Engine version

234

833

8.5.7

ExtremeCloud IQ
- Site Engine (all
Versions)

Extreme
Management
Center version
855,856, 0r
8.5.7

Extreme
Management
Center version
85.0-854

Extreme
Management
Center version
8.4.4

*Extreme
Management
Center version
8.4.0-8.4.3
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General Information

Upgrade to
ExtremeCloud 1Q -
Site Engine version
Current Version 234
833 8.5.7

*Extreme X X

Management

Center version

8.2.x or 8.3.x

Extreme X X X

Management

Center version

8.0.x or 8.1.x

NetSight version X X X

7.1 or older

A backup (Administration > Backup/Restore) of the database must be performed

IMPORTANT: prior to the upgrade and saved to a safe location.

During the installation (if upgrading using the user interface installer), you have the option to
backup additional user files by selecting a checkbox on the Previous Installation Detected
screen. This option lets you backup user files such as Inventory Manager archive files not
automatically backed up during the install because the backup could take several minutes.

Important Upgrade Considerations

 |f your network is using ExtremeAnalytics or ExtremeControl engines, Fabric Manager, or another add-
on feature, you must first perform the ExtremeCloud 1Q - Site Engine upgrade to version 23.04.11 and
then upgrade the feature.

¢ Fabric Manager version 22.09.13.5 is compatible with ExtremeCloud 1Q - Site Engine version 23.4. If you
are running a previous version of Fabric Manager, upgrade your deployment to Fabric Manager
22.09.13.5 for use with ExtremeCloud IQ - Site Engine version 23.4.

e To upgrade Traffic Sensor from version 21.x, a fresh installation is recommended. If the fresh installation
cannot be used, then please check Knowledge Base for a special procedure.

Upgrading ExtremeControl Engine to Version 23.04.11

General Upgrade Information

You are not required to upgrade your ExtremeControl engine version to 23.04.11 when
upgrading to ExtremeCloud 1Q - Site Engine version 23.04.11. However, both ExtremeCloud 1Q -
Site Engine and ExtremeControl engine must be at version 23.04.11 in order to take advantage of
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Pre-Installation Checklist

the new ExtremeControl version 23.04 .11 features. ExtremeCloud |Q - Site Engine version
23.04.11 supports managing ExtremeControl engine versions 8.5.7, 21.x, 22.x, and 23.04.11.

In addition, if your ExtremeControl solution utilizes a Nessus assessment server, you should also
upgrade your assessment agent adapter to version 23.04.11if you upgrade to ExtremeControl
version 23.04.11.

You can download the latest ExtremeControl engine version at the Extreme Portal.

Agent Version for NAC Agent-Based Assessment

If you are using onboard agent-based assessment, be aware that the agent version is upgraded
during the ExtremeControl engine software upgrade. If you would like end-systems to update
their agent to the new version, you must configure your assessment test set to test for the new
agent version. Refer to the Important Upgrade Information section in the ExtremeCloud IQ - Site

Engine Release Notes or the agent version included in the ExtremeControl engine software.

Upgrading to Policy Manager 23.04.11

¢ Policy Manager 23.04.11 only supports ExtremeWireless Controller version 8.01.03 and higher. If you
upgrade to ExtremeCloud 1Q - Site Engine 23.04.11 prior to upgrading your controllers, then Policy
Manager does not allow you to open a domain where the controllers already exist or add them to a
domain. A dialog is displayed indicating your controllers do not meet minimum version requirements
and that they must be upgraded before they can be in a domain.

* Following an upgrade to Wireless Controller version 8.31and higher, a Policy Manager enforce fails if it
includes changes to the default access control or any rules that are set to contain. To allow Policy
Manager to modify the default access control or set rules to contain, you must disable the "Allow" action
in policy rules contains to the VLAN assigned by the role checkbox accessed from the Wireless
Controller's web interface on the Roles > Policy Rules tab. This will allow the enforce operation to
succeed.

Pre-Installation Checklist

Please review the following checklist prior to performing an ExtremeCloud IQ - Site Engine
software installation or upgrade.

Backup database. If performing an upgrade, be sure to backup the Extreme Management
Center database prior to performing the upgrade. Use the Backup/Restore tab to perform the
backup (Administration > Backup/Restore tab).

If you are an existing Extreme Management Center customer, contact your representative to
have your Extreme Management Center license migrated to an ExtremeCloud 1Q - Site Engine
license. The ExtremeCloud |Q - Site Engine license also includes licensing for ExtremeAnalytics.
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e Forupgrade and installation requirements, as well as configuration considerations, see
ExtremeCloud IQ - Site Engine Configuration and Requirements.

¢ ExtremeCloud IQ - Site Engine version 23.04.11 receives the licenses from

IMPORTANT: ExtremeCloud 1Q. ExtremeCloud 1Q - Site Engine is a subscription-based -only

licensing model. Existing NMS licenses do not provide access to ExtremeCloud 1Q -
Site Engine. You can view the status of your license by accessing Administration >
Licenses.

ExtremeCloud IQ - Site Engine Installation

If you are an existing Extreme Management Center customer, contact your representative to
have your Extreme Management Center license migrated to an ExtremeCloud |Q - Site Engine
license. The ExtremeCloud IQ - Site Engine license also includes licensing for ExtremeAnalytics.

Installing ExtremeCloud IQ - Site Engine

Use the following instructions to install ExtremeCloud |Q - Site Engine. Please read through the
following items before beginning the installation.

The user performing the installation must be the root user. During the installation process you can
specify another user to launch and run the server, if desired.

If you are installing ExtremeCloud IQ - Site Engine on a Linux system that doesn't support a GUI, see
Performing a Silent Install for information on installing ExtremeCloud 1Q - Site Engine without using its

GUI Installation wizard.

If you are installing ExtremeCloud IQ - Site Engine on a Linux system that requires an operating system
upgrade, you are prompted to upgrade using either an internet connection or locally if no additional
Ubuntu packages need to be installed.

Prior to beginning installation, verify that your /etc/hosts file has the local host name specified. It should
have an entry that looks like:
127.0.0.1 localhost

You may encounter a Java exception during the install when becoming the root user with the su -
command. Be sure that your system'’s root environment has a proper DISPLAY variable setting. The
Installation program reports a Java exception (InvocationTargetException) if the DISPLAY variable is
undefined. If this occurs:

Before using the su - command, set the system display variable to accept a remote display with the
command:

/usr/openwin/bin/xhost +test 111 111

After using the su - command, set the display variable in the environment where the su - was done.

For Cshell: setenv DISPLAY :0.0

For Korn shell: export DISPLAY=:0.0
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Preparing for CD Installation

Perform the following steps if you will be installing the ExtremeCloud I1Q - Site Engine software
from a CD. The following procedures assume that the CD drive from which you are installing is
physically attached to the system where ExtremeCloud IQ - Site Engine is being installed.

1. Insert the ExtremeCloud IQ - Site Engine CD into the CD drive.

2. Use an xterm where you are logged in as root. (Be sure that your system'’s root environment has a
proper DISPLAY variable setting. For more information see the above note.)

3. Using the cd command, cd to the /mnt /cdrom directory.

4. Using the Is command, check to see if the CD drive is mounted. If no files are listed, issue the following
commands:
mount /mnt/cdrom
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Install and Launch ExtremeCloud I1Q - Site Engine

1.
2.

9.

Download X/Q-SE Install and Upgrade from the ExtremeCloud |Q section of the Extreme Portal.

Use an xterm where you are logged in as root. (Be sure that your system’s root environment has a
proper DISPLAY variable setting. For more information see the above note.)

Change the permissions on the upgrade file by entering the following command:
chmod u+x File Name <version> install.bin

If installing ExtremeCloud IQ - Site Engine on a system on which Ubuntu 18.04 LTS (Bionic Beaver) is
installed, continue to step 5; otherwise, proceed to step 9.

Editthe rsyslog.conf file.

Uncomment (remove the # from the beginning of the line) for the lines that include imudp/514 and
imtcp/514:

#ENABLE_RSYSLOG_SERVICE

cp /etc/rsyslog.conf /etc/rsyslog.conf.original

sed -i 's/#module(load=\"imudp\")/module(load=\"imudp\")/g' /etc/rsyslog.conf

sed -i's/#input(type=\"imudp\" port="514")/input(type=\"imudp\" port="514")/g’ /etc/rsyslog.conf
sed -i's/#tmodule(load=\"imtcp\")/module(load=\"imtcp\")/g’ /etc/rsyslog.conf

sed -i 's/#input(type=\"imtcp\" port="514")/input(type=\"imtcp\" port="514")/q' /etc/rsyslog.conf
systemctl restart rsyslog

Editthe /etc/hosts file.

Ensure the ip fgdn hostname line is configured (the last line in the following codeblock):

#IF_DNS_NOT_CONFIGURED

hostnamect! set-hostname <set_your_hostname_here>
domainname <set_your_domain_here>

export HOST_IP="hostname -ilawk '{print $1}'*

export HOST_FQDN="hostname -f*

export HOST_NAME="hostname"

cp /etc/hosts /etc/hosts.original

echo $HOST_IP $HOST_FQDN $HOST_NAME >> /etc/hosts
#

# If DNS is configured on the system ensure the /etc/hosts contains an
# entry of the format:

# <ip> <fgdn> <hostname>

#192.168.1.150 xmc1804.extremenetworks.com xmc1804

Start the Installer.

 |f you have downloaded the software, cd to the directory where you downloaded the installer
and start the Installer with the following command:
./ExtremeCloudIQSiteEngine <version> 64bit install.bin
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10.

¢ [fyou areinstalling from a CD, start the installer with the command:
/mnt/cdrom/ExtremeCloudIQSiteEngine <version> 64bit install.bin

The ExtremeCloud IQ - Site Engine Installer leads you through a series of windows that ask for all the
information required in order to install ExtremeCloud IQ - Site Engine. You need the following
information for the Installer Program:

» Service Configuration - There are two Service Configuration screens.

° Inthe first screen, you can specify a user other than root to own the ExtremeCloud 1Q -
Site Engine server and its supporting files, if desired. This user becomes the admin user for
the server. Select Use existing user if you already have a user defined on the machine and
enter the user name. Select Create local netsight user if you want to create a new
"netsight” user (netsight is the user name) and enter the password for this new user.
Leave the Use existing user option set to root if you do not want to specify another user.

° |n the second screen, enable and start the ExtremeCloud 1Q - Site Engine Services. (For
more information on the services offered on the Linux platform, see ExtremeCloud 1Q -
Site Engine Services.)

+ Destination Directory - This is the path to your ExtremeCloud IQ - Site Engine Installation
Directory. In the Destination Directory window, select Choose to navigate to the directory, or
type the path in manually.

¢ QOperating System Upgrade Method — If your Linux system requires an operating system
upgrade, you are prompted to upgrade using either an internet connection or locally (without an
internet connection) if no additional Ubuntu packages need to be installed:

IWATTENTION !

We can attempt to upgrade the OS without using the Internet if there were no extra Ubuntu
packages installed. If there were extraneous packages installed, the upgrade will fail with this
method.

Do you want to attempt a local in-place upgrade of the OS and reboot when complete? (Y/n)

When you have finished with this series of windows, ExtremeCloud IQ - Site Engine is installed
according to your specifications.

. When the installation is complete, the database and server are started automatically. You must wait

until the ExtremeCloud IQ - Site Engine server has started all its various server components before you
can connect to the server and launch the ExtremeCloud IQ - Site Engine applications. On the installation
screen, you see an hourglass icon while the server starts its components. When the server is ready for
connections, the installation screen displays a green check.

On the installation screen, select the Show Launch Page link to open the ExtremeCloud 1Q - Site Engine
Launch Page.

The ExtremeCloud 1Q - Site Engine Launch Page opens. At the top of the web page you will see tabs for
the following functions:

19 of 42



ExtremeCloud IQ - Site Engine Installation

¢ Home - Launch your ExtremeCloud IQ - Site Engine applications by selecting the names or icons
of any of the listed applications.

e (Getting Started - In order to launch your ExtremeCloud 1Q - Site Engine applications, you must
have Java Runtime Environment (JRE) 6 (also referred to as 1.6) or higher installed on your
system. This page tells you if you have met this requirement and provides instructions for
installing the Java Runtime Environment (JRE), if required.

« Administration - Provides access to specific server administration functions such as client and
server diagnostics, and server utilities.

14. Verify that you have met the JRE requirement by accessing the Getting Started tab, and install the JRE
according to the instructions on the Install Java tab, if required.

15. Select the Home tab and launch the desired ExtremeCloud 1Q - Site Engine application by selecting the
name or icon.

16. Alogin window appears. ExtremeCloud IQ - Site Engine requires a user login as a way to restrict access
to the ExtremeCloud IQ - Site Engine server, perform audit trails, and assign user capabilities according
to the Authorization Group the user belongs.

a. Select the ExtremeCloud 1Q - Site Engine server to which you wish to connect.
b. Enter your username.

c. Enter your password and select OK.

NOTES: The initial user to log in must be the user that performed the ExtremeCloud IQ - Site
Engine installation, which is either root or the user defined in the Service
Configuration screen during the installation. This is because the ExtremeCloud I1Q -
Site Engine server has a single pre-defined user. After the initial user has logged in,
additional users can be defined.

The password for the root user does not expire. To configure the password to age so
it expires after 60 days, see Configure Your Password to Expire.

17. The application main window opens.

Performing a Silent Install

If you are installing ExtremeCloud IQ - Site Engine on a Linux system that doesn't support a GUI,
you must add the cli flag (--cli) to the install coommand, in order to allow the ExtremeCloud 1Q -
Site Engine installer to prompt for any required input.

Start the installation with the following command:
./ExtremeCloudIQSiteEngine <version> 64bit install.bin --cli

If you are installing as a user other than root, you must use the --user command to specify the
different user. The user must already be configured on the machine before you install. For
example:
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./ExtremeCloudIQSiteEngine <version> 64bit install.bin --cli --user
<username>

To perform the install and create a new local "netsight” user (where netsight is the user name),
use the --password command to set the password for the new "netsight” user. For example:

./ExtremeCloudIQSiteEngine <version> 64bit install.bin --cli --password
<password>

Select the deployment mode and licensing for ExtremeCloud 1Q -
Site Engine
After installing or upgrading to ExtremeCloud |Q - Site Engine, you need to select your

deployment mode and licensing for ExtremeCloud |IQ - Site Engine. Refer to First log in to
ExtremeCloud IQ - Site Engine for the procedure.

Post Installation Procedure for Ubuntu 18.04 LTS (Bionic Beaver)

If installing ExtremeCloud |Q - Site Engine on a system on which Ubuntu 18.04 LTS (Bionic
Beaver) is installed, follow this procedure when ExtremeCloud |IQ - Site Engine is installed:

1. Open acommand prompt on the ExtremeCloud 1Q - Site Engine server.

2. Entercp /var/Extreme Networks/.netsight /var/Extreme
Networks/.netsight.original.

3. Enterexport HOST IP="hostname -ilawk '{print $1}'"
4. Enter sed -i "\$aJBOSS HOSTNAME=S$HOST IP" /var/Extreme Networks/.netsight
5. Install OpenSSH for SCP-based archives support and allow root login:
a. Openthe /etc/ssh/sshd config file and change PermitRootLogin to yes.
b. Enterapt-get install openssh-server.
6. Allow root access to the ExtremeCloud |Q - Site Engine server via SSH.
a. Entercp /etc/ssh/sshd config /etc/ssh/sshd config.original

b. Entersed -i 's/#PermitRootLogin prohibit-password/PermitRootLogin
yes/g' /etc/ssh/sshd config

Restoring a Database from a Windows Server to a Linux Server

This section describes several ExtremeCloud IQ - Site Engine configuration changes required if
you are moving your ExtremeCloud IQ - Site Engine installation from a Windows platform
system to a Linux platform system. The steps are performed after restoring your database to
the new server.

In addition, there are two changes that must be made in the legacy Console java application and
one change in the legacy Inventory Manager application.
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Console

Use the following instructions to change the location of syslog and trap information to the new
location on the Linux system.

Syslog

Change the Syslog Log Manager to point to the new location on the Linux system. This allows
the display of syslog information in the Syslog Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2. Select the Syslog entry under Available Log Managers, and select the Edit button. The Log Manager
Parameters window opens.

3. Change the path in the Log Directory field to /var/log/syslog.
4. Change the Pattern to Red Hat LINUX Syslog Pattern.
5. Select OK.

Traps

Change the Traps Log Manager to point to the new location on the Linux system. This allows the
display of trap information in the Traps Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2. Select the Traps entry under Available Log Managers, and select the Edit button. The Log Manager
Parameters window opens.

3. Change the path in the Log Directory field to %logdir%/traps.
4. Select OK.

Inventory Manager

If you are using Inventory Manager, you need to change the Data Storage Directory path to
point to the new location on the Linux system. The Data Storage directory is where all Inventory
Manager data is stored, including capacity planning reports, configuration templates, archived
configurations, and property files.

1. From the Inventory Manager menu bar, select Tools > Options. Expand the Inventory Manager options
folder and select Data Storage Directory Path.

2. Change the path to the correct new location. On a default Linux install, the path would be:
<user's home directory>/appdata/InventoryMgr

3. Select OK.
Systems with Multiple NICs

This section provides instructions for configuring ExtremeCloud 1Q - Site Engine servers with
multiple NICs (Network Interface Cards). During the startup process, the ExtremeCloud |1Q - Site
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Engine server automatically binds to the first available NIC, which may not be the correct
interface for the server to use. In addition, changes on the network can cause the server to bind
to anincorrect interface, should the server restart during a change.

If the system has multiple NICs installed, it is a good practice to either:

e configure the server to bind to a preferred IP address, if using only one interface for connections or

« configure multiple network interfaces, if using more than one interface for connections.

This ensures that local and remote clients, as well as ExtremeControl engines, are able to
connect to the ExtremeCloud IQ - Site Engine server.

Binding to One Interface

If the ExtremeCloud IQ - Site Engine server has multiple NICs installed but only one interface is
used to access ExtremeCloud 1Q - Site Engine, use the following instructions to configure the
preferred interface for the ExtremeCloud 1Q - Site Engine server.

Configure the ExtremeCloud |Q - Site Engine server to bind to the correct IP address.

1. Openthe /var/Extreme Networks/.netsight file. Edit theline JBOSS HOSTNAME=<server
IP> to add the correct NIC IP address.

2. Restart the ExtremeCloud IQ - Site Engine server.

NOTE: User preferences and application data (such as FlexViews and MIBs) for remote clients are stored in
the following local directory on the client machine: C:\Documents and
Settings\<username>\Application Data\NetSight.

Uninstalling ExtremeCloud IQ - Site Engine

Use the procedures below to uninstall your ExtremeCloud |Q - Site Engine Suite of products.
The uninstall removes all ExtremeCloud |Q - Site Engine data from the database. Be sure to
backup your database prior to uninstalling.

Navigate to the <install directory>/uninstaller directory and start the Uninstaller by issuing the
command:
./uninstall.sh

Extreme Networks Support

If you require assistance, contact Extreme Networks Global Technical Assistance Center using
one of the following methods.

Web www.extremenetworks.com/support/
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Phone 1-800-872-8440 (toll-free in U.S. and Canada) or 1-603-952-5000
For the Extreme Networks Support phone number in your country:
www.extremenetworks.com/support/contact/

Email support@extremenetworks.com
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ExtremeCloud IQ - Site Engine Licensing

ExtremeCloud IQ - Site Engine includes all the features and functionality of Extreme
Management Center. If you are an existing Extreme Management Center customer, contact your
representative to have your Extreme Management Center license migrated to an ExtremeCloud
|IQ - Site Engine license. The ExtremeCloud IQ - Site Engine license also includes licensing for
ExtremeAnalytics.

e ExtremeCloud |Q - Site Engine is a subscription-based -only licensing model.

NOTES: e isnot compatible with ExtremeCloud |Q - Site EngineExtremeCloud |Q Connect level account.
The Pilot level is mandatory.

You can view ExtremeCloud |Q and ExtremeCloud |1Q - Site Engine license information by
accessing Administration > Licenses.

This Help topic includes information on the following:

¢ Licensing for Devices in Connected Mode

e Licensing for Devices in Air Gap Mode

¢ Revoke Air Gap License

e License Limits and Violations

e Licensing for ExtremeControl

There are three tiers of licenses for ExtremeCloud |Q - Site Engine and devices:

¢ Pilot - Natively supported Extreme devices

» Navigator - 3rd party devices, Extreme Campus Controller, ExtremeCloud 1Q Controller, WiNG wireless
devices, and devices not natively supported by ExtremeCloud IQ - Site Engine

¢ No License - Status-Only devices

ExtremeCloud IQ - Site Engine can be deployed in two ways, using connected mode or air gap
mode:

e Connected mode:

e ExtremeCloud IQ - Site Engine uses ExtremeCloud 1Q to determine if you meet or exceed the
license limits for each license type.

+ All ExtremeCloud IQ - Site Engines connected to the same customer account share a pool of
licenses, one serial number consumes one license entitlement, regardless of the number of
monitoring entities.

o ExtremeCloud IQ - Site Engine shares information with ExtremeCloud IQ.

¢ ExtremeCloud IQ can cooperate with ExtremeCloud I1Q - Site Engine.
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Licensing for Devices in Connected Mode

¢ Air gap mode:
¢ ExtremeCloud IQ - Site Engine does not require internet access.

e ExtremeCloud IQ - Site Engine uses a license file to determine if you meet or exceed the license
limits for each license type.

¢ ExtremeCloud IQ - Site Engines can not share licenses.

Devices that do not have serial numbers or MAC addresses in Extreme
Management Center must be Rediscovered after you upgrade to
ExtremeCloud IQ - Site Engine in connected mode before they can be
onboarded to ExtremeCloud IQ.

If your number of devices exceeds your licenses available, ExtremeCloud 1Q -
Site Engine transitions to a license violation state and your access to
ExtremeCloud IQ - Site Engine features and functionality is degraded. To
resolve the license shortage you need to access the Extreme Networks
License Portal or ExtremeCloud IQ to evaluate the quantities of available
Pilot, Navigator, and NAC licenses versus the number of licenses required by
ExtremeCloud IQ - Site Engine.

NOTE:

Licensing for Devices in Connected Mode

When ExtremeCloud IQ - Site Engine has been onboarded, it starts sending requests to add the
devices from its database to ExtremeCloud 1Q.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they are onboarded to
ExtremeCloud IQ, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

Devices may be marked as Unmanaged in ExtremeCloud 1Q, which means they are not using a
license and available features are very limited.

The following grid details the type of license required by each device and engine type:

Number of
Device Type License Tier Type Licenses Per
Device

Extreme-supported Device (Includes Universal
Platform Fabric Engine, Universal Platform VOSS,
VSP series, SLX, Extreme Access Series, VDX Pilot 1
Series, Fabric Manager, ICX Series, Security
Appliances, MLXe Series, VDX Series)
Extreme-supported Device (Universal Platform
Switch Engine, Universal Platform EXOS, Summit
Series, ERS Series, A Series, B Series, C Series,
7100 Series, 200 Series)

Pilot 1 for each unit
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Number of
Device Type License Tier Type Licenses Per
Device
Extreme-supported Device (S-Series, K-Series) Pilot 1 for each chassis
Extreme-supported Chassis (Includes S series, K
series, N series, E series, Black Diamond, Black Pilot 1 for each chassis
Diamond X, X series, VSP series, MLXe series,
VDX series, SLX series)
ExtremeControl engine Pilot 1
ExtremeAnalytics engine Pilot 1
ExtremeCloud 1Q - Site Engine* Pilot 1
vSensor Pilot 1
All Other Devices (Includes Non-Extreme .
. Navigator 1
Device) —_—
Devices with Ping-Only profile No License 0

*There is one license required for the ExtremeCloud 1Q - Site Engine itself. If there are
more ExtremeCloud |Q - Site Engine, then only one license is consumed.

For HiveOS APs (IQE) and Dell N-Series, a Pilot license is required, but currently not
NOTE: enforced in ExtremeCloud IQ - Site Engine. These are not onboarded to ExtremeCloud IQ
through ExtremeCloud 1Q - Site Engine.

Licensing for Devices in Air Gap Mode

ExtremeCloud IQ - Site Engine uses licenses stored locally in a license file. This ensures
ExtremeCloud IQ - Site Engine does not require an internet connection to verify licenses are
available as you add devices.

Licenses in one installation of ExtremeCloud 1Q - Site Engine in air gap mode cannot be

NOTE: shared with other installations of ExtremeCloud IQ - Site Engine.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they consume a license
of the appropriate tier (Navigator, Pilot or No License) that each device requires against the
total listed in the license file.
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Revoke Air Gap License

Devices may be marked as Unmanaged, which means they are not using a license and available
features are very limited.

The following grid details the type of license required by each device and engine type:

Number of
Device Type License Tier Type Licenses Per
Device

Extreme-supported Device (Includes Universal
Platform Fabric Engine, Universal Platform
VOSS, VSP series, SLX, Extreme Access Series, Pilot :
VDX Series, Fabric Manager, ICX Series, Security
Appliances, MLXe Series, VDX Series, HiveOS
(IQE), Dell N-Series)
Extreme-supported Device (Universal Platform
Switch Engine, Universal Platform EXOS, Pilot 1 for each unit
Summit Series, ERS Series, A Series, B Series, C
Series, 7100 Series, 200 Series)
Extreme-supported Chassis (Includes S series, K
series, N series, E series, Black Diamond, Black Pilot 1 for each chassis
Diamond X, X series, VSP series, MLXe series,
VDX series, SLX series)
ExtremeControl engine Pilot 1
ExtremeAnalytics engine Pilot 1
ExtremeCloud 1Q - Site Engine* Pilot 1
vSensor Pilot 1
All Other Devices (Includes Non-Extreme .

. Navigator 1
Device) —_—
Devices with Ping-Only profile No License 0

*There is one license required for the ExtremeCloud |Q - Site Engine itself. If there are
more ExtremeCloud |Q - Site Engine, then only one license is consumed.

Revoke Air Gap License

NOTE: A maximum of 10 Air Gap licenses can be revoked in one revocation file.

Follow this procedure to revoke your Air Gap license.
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1. Open Administration > Licenses or enter this URL.
https://<Server>:/8443/xiglLicenseSetup.jsp?setupMode=Airgap

2. Select either the Pilot, Navigator, or NAC license to revoke.
ExtremeCloud IQ - Site Engine generates a revocation file.
3. Download the file to your computer.

4. Log into the Extreme Portal (https://extremeportal.force.com/ExtrCloudLicenselanding).

5. Select Assets > Cloud Licenses Home > Revoke License.

EXJ[I’er"ﬂe Portal Support Products Downloads Assets Renewals

Assets Home
Search
Licenses Home
Cloud i'Eenses Home
)

Cloud Licenses Home

Claim Voucher Generate License License Transfer Revoke License
Claim your Perpetual Generate license for Pilot, Transfer a license from Revoke 3 license from a
Entitlement Vouchers. Mavigator & NAC products. defective to replacement working unit.

unit.

Claim Voucher Generate License License Transfer Revoke License

6. Upload the revocation file and select Submit.

Revoke License
Upload a valid revocation file from product

Revocation License File

* || Choose File | No file chosen

Cancel

The revoked licenses are returned to the license pool. Contact support if you encounter an error.
You will need to provide the revocation file (. rvk) and the error message.

License Limits and Violations

For each request to add a device to ExtremeCloud 1Q - Site Engine:

¢ In connected mode: ExtremeCloud IQ determines if there are enough licenses of that type available.

¢ |nair gap mode: ExtremeCloud IQ - Site Engine uses the license file to determine if there are enough
licenses of that type available.
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License Limits and Violations

As a result for both modes, one of the following actions happens:
e |fthere are enough licenses, device onboarding is successful.
e |f there are not enough Navigator licenses, a Pilot license is used instead.

 |f there are not enough Pilot licenses, the request is considered a license violation.

When an evaluation license is used for ExtremeCloud |Q - Site Engine, all devices are

NOTE managed with Pilot licenses.

To correct a license limit violation:

¢ |n connected mode: You must acquire more licenses (and, when the updated licenses are available in
ExtremeCloud IQ, they are used by ExtremeCloud IQ - Site Engine).

¢ |nair gap mode: You must acquire more licenses by generating a new licensing file from the licensing
portal, then install the licensing file in ExtremeCloud 1Q - Site Engine.

Devices Marked as Unmanaged

When devices are marked as Unmanaged in ExtremeCloud IQ, they are also Unmanaged in
ExtremeCloud IQ - Site Engine.

Onboarded Unmanaged devices are indicated in the XIQ Onboarded column of the Network >
Site > Device table by ared X.

For more details on the Network > Site > Device table, visit Onboarding Unmanaged Devices.
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Licensing for ExtremeControl (Network Access Control)

Licensing for ExtremeControl (Network Access Control)

If the ExtremeCloud IQ - Site Engine was onboarded to ExtremeCloud 1Q, ExtremeCloud 1Q
provides the Network Access Control (NAC) entitlements to ExtremeCloud 1Q - Site Engine.
There is an option to allocate a portion of the available license pool in ExtremeCloud IQ. The full
100% NAC entitlements should be allocated automatically to the first ExtremeCloud I1Q - Site
Engine. If there are more Site Engines, for example, a lab instance and a production instance,
then the NAC entitlements allocation can be changed in the ExtremeCloud 1Q GUI. It is
recommended to check the NAC entitlements allocation in ExtremeCloud 1Q.

If the ExtremeCloud IQ - Site Engine is operated in air gap deployment mode, the licensed
quantity for ExtremeControl is provided through a license file. The license file is generated in
Extreme Portal. The licensed quantity for ExtremeControl varies depending on whether
ExtremeCloud IQ - Site Engine is initially installed or it was upgraded from the Extreme
Management Center.

After Upgrading from Extreme Management Center

If you are upgrading from Extreme Management Center to ExtremeCloud IQ - Site Engine, the
licensing and capabilities of ExtremeControl do not change. The following are included in the
licenses:

¢ NMS-ADV License includes 500 Access Control End-Systems and 50 Guest and loT Manager
(GIM) licenses.

¢ NMS-xx License includes 250 Access Control End-Systems and 25 GIM licenses.

If your version of ExtremeControl contains NMS or NMS-ADV licenses described above and licenses are
NOTE: used through ExtremeCloud IQ (in Connected mode) or in a locally stored license file (in Air Gap
mode), ExtremeControl will sum those licensed quantities.

Upon Initial Installation

If you are completing an initial install of ExtremeCloud |Q - Site Engine, there is no end-system
license included. The evaluation license can be generated on the Extreme Portal which includes
unlimited end-systems and Guest and IoT Manager (GIM) licenses.
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Post upgrade from Extreme Management Center Version 8.5.50r 8.5.6

Logging into ExtremeCloud IQ - Site Engine

In connected mode, ExtremeCloud IQ - Site Engine gets licenses through ExtremeCloud 1Q.
ExtremeCloud IQ acts as a license proxy between ExtremeCloud |Q - Site Engine and Extreme
Portal. Therefore, your ExtremeCloud |Q needs to be linked to your license entitlements in the
Extreme Portal before your ExtremeCloud |Q - Site Engine can be onboarded to ExtremeCloud
|Q and consumes licenses via ExtremeCloud I1Q. In Air Gap deployment mode, ExtremeCloud 1Q
- Site Engine utilizes these licenses based on a license file.

Post upgrade from Extreme Management Center Version
8.5.5 or 8.5.6

When the Extreme Management Center is onboarded to ExtremeCloud 1Q using the soft launch
feature, you need to remove Extreme Management Center from ExtremeCloud IQ before
onboarding ExtremeCloud IQ - Site Engine.

Initial installation of ExtremeCloud IQ - Site Engine or
upgrading from Extreme Management Center

Follow these steps to launch ExtremeCloud IQ - Site Engine:

1. Enterthis https://<IP Address>:8443 inyour browser.

ExtremeCloud 13 Site Engine

2. Enter your ExtremeCloud IQ - Site Engine login credentials and select Login. These are the credentials
you configured during the installation
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Initial installation of ExtremeCloud IQ - Site Engine or upgrading from Extreme Management

3. Accept the License Agreement and select Next.

Welcome to ExtremeCloud 1Q - Site Engine

License Agreement

PLEASE READ ALL OF THE FOLLOWING TERMS AND CONDITIONS OF THIS END USER LICENSE AGREEMENT. .-

This End User License Agreement {("Agreement”) iz a legal agreement between You and/or the entity You represent
and Extreme MNetworks, Inc., on behalf of itself and its affiliates, including, but not limited to, Extreme Metwork Ireland
Ops Limited (colleclively, "Extreme”) for the Software (defined below) licensed by Extreme or its licensors.

By downloading, installing, copying, accessing, or using the Software, or aclivating a Software license key, or by
clicking an "I Agree” or similar button, or by opening the Software media, You agree to the terms and conditions of this
Agreement as a condition of Your use of, and right to use, the Software.

If You do nof agree fo all the terms and conditions in this Agreement, do not download, install or use the Software. If the
Software was delivered to You embedded in an Extreme Hardware Product, do not install or use that Extreme
Hardware Product.

Extreme may make changes to this Agreement at any time and will provide written notice of such changes to You and
give You an oppeoriunity to accept those changes. Your continued use of the Software after such changes have been
posted will signify your assent to acceptance of the revised terms.

IT You and Extreme have signed a separate written agreement covering Your rights and duties with respect to the
Software, then that written agreement take precedence over any conflicting ferms in this Agreement.

Your privacy is important to Exireme. Extreme’s Privacy Policy is located at

hitps:/fwww extremenetworks .com/company/legaliprivacy/. Please read our Privacy Policy for information related to
Extreme's collection, use and disclosure of Your personal information. By agreeing to the terms of this Agreement, You
are alzo accepting the terms of Exireme's Privacy Policy.

| accept the License Agreement

4. Select your deployment mode. Refer to the XIQ-SE Activation document for licensing information.

¢ Connected mode - Onboard to ExtremeCloud IQ - Site Engine - In connected deployment mode,
ExtremeCloud IQ - Site Engine utilizes these licenses through connection to ExtremeCloud 1Q. It
is required to link your Extreme Portal to ExtremeCloud Q. Once those are linked together, you
can use the licenses you purchased in both ExtremeCloud 1Q and ExtremeCloud IQ - Site Engine.

» Air Gap mode - Enter entitlement(s) for air gapped ExtremeCloud IQ - Site Engine - In air gap
deployment mode, ExtremeCloud 1Q - Site Engine utilizes these licenses based on a license file.
During the generation of the license file, the licenses are assigned to the locking ID of
ExtremeCloud IQ - Site Engine.
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Initial installation of ExtremeCloud IQ - Site Engine or upgrading from Extreme Management

Welcome to ExtremeCloud IQ - Site Engine

Select the deployment model that meets the requirements of your ExtremeCloud 1Q - Site Engine.

5 _ Onboard to ExtremeCloud IQ
=] @ (Start here if you have internet connectivity)

__ Enter entitlement(s) for air gapped ExtremeCloud IQ - Site Engine
== (O (Start here if you do not have internet connectivity)

Need to restore a backup? Follow this

The Welcome screen provides a link to the procedure for restoring ExtremeCloud 1Q -

NOTE: Site Engine from backup.

5. Click Next.
6. Depending on the deployment mode you selected, you will do one of the following:

e For Connected mode onboarding of ExtremeCloud 1Q - Site Engine to ExtremeCloud 1Q, enter
the ExtremeCloud 1Q email address and password and select Onboard. If your environment
requires HTTP Proxy or other advanced settings, select the Advanced link. If you do not have an
ExtremeCloud 1Q account, select the Register Here link.
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Initial installation of ExtremeCloud IQ - Site Engine or upgrading from Extreme Management

Welcome to ExtremeCloud IQ - Site Engine

Back Onboard to ExtremeCloud 1Q

Please enter your ExtremeCloud |Q credentials to onboard the ExtremeCloud 1Q - Site Engine.

Email
Password

Don't have an account? Register here

e For Air Gap deployment, drag and drop your entitlements to this screen.

Advanced

Welcome to ExtremeCloud 1Q - Site Engine
Back Air Gap License Entitlements

Enter the entitlement(s) for your air gapped ExtremeCloud IQ - Site Engine.
After adding entitlements to the table below, click the Continue button to log in to ExtremeCloud 1Q - Site Engine.

ExtremeCloud 1Q - Site Engine serial number (Locking ID, UUID): XIQSE-4464725328CD4130B8D425187D41000

Don't have a license file? Generate here
Entitlements (]

Drag and drop a license entitlement file into this zone or click here to paste license entitlements.

Feature License Name Type Quantity Start Date End Date Description

PRD-XIQ-MNAV-5-C XIQ-NAV-5-C Subscription 20 ;;ggﬁg?m ;éggggﬁd ExtremeCloud IQ - Site Engine - Navigator i
PRD-XIQ-PIL-5-C XIQ-PIL-5-C Subscription Unlimited ;;ggﬁg?m ;éggggﬁd ExtremeCloud IQ - Site Engine - Pilot i
PRD-XIQ-NAC-S XIQ-NACS Subscription 100,000 ;;j;g:’ DZDO?M :]é:’ ; ;,;folgilm E’éﬁ:fr’gfc' oud 1Q - Site Engine - Access []

Displaying 3 rows
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Onboarding Devices (Connected mode only)

7. Click Onboard (Connected mode) or Continue (Air Gap mode). ExtremeCloud 1Q - Site
Engine is ready to use.

You can now access ExtremeCloud 1Q - Site Engine.

If you need to convert your deployment between Connected or Air Gap mode,
NOTE: see Convert from Connected to Air Gap deployment or Convert from Air Gap to
Connected deployment.

Onboarding Devices (Connected mode only)

When ExtremeCloud |Q - Site Engine is onboarded, it starts sending requests to add the devices
from its database to ExtremeCloud 1Q. Cloud Configuration Groups are created in
ExtremeCloud IQ that match User Device Groups in ExtremeCloud IQ - Site Engine.

Devices with IPv6 addresses in ExtremeCloud 1Q - Site Engine will not be
NOTE: onboarded as locally-managed devices in ExtremeCloud 1Q. Only devices with
IPv4 addresses qualify.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they are onboarded to
ExtremeCloud IQ, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

If devices that are onboarded are included in User Device Groups in ExtremeCloud 1Q - Site
Engine, they are also included in Cloud Configuration Groups in ExtremeCloud |Q that match the
devices' assigned User Device Groups in ExtremeCloud 1Q - Site Engine.

Cloud Configuration Groups are updated when devices are added to User Device Groups (either
by user action or by API call). Cloud Configuration Groups are also updated when devices are
removed from a User Device Group or deleted from ExtremeCloud 1Q - Site Engine.

Cloud Configuration Group names include User Device Group parent names
(other than "My Network") and are prefixed with "XIQSE-".

The Cloud Configuration Group names will be shortened to fit the limit of 128
characters.

NOTE:

View the ExtremeCloud 1Q - Site Engine and ExtremeCloud IQ Onboarding Flowchart for a
detailed chart on how devices are onboarded to ExtremeCloud IQ and managed by
ExtremeCloud IQ - Site Engine.

X1Q Onboarded Status for Devices (Connected mode
only)

After an attempt is made to onboard a device, the XIQ Onboarded column in the table Network
> Site > Device) indicates the status of the onboarding attempt.
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X1Q Onboarded Status for Devices (Connected mode only)

¢ Black check mark - Indicates that the device is onboarded to ExtremeCloud IQ.

¢ Red X - Indicates the device is onboarded but Unmanaged, which means it is not using a license, it has
read-only device-level support, and available features in ExtremeCloud IQ - Site Engine are limited.
Other functionality, including Status Polling, Historical Device + Port Statistics Collection, Existing
Scheduled Tasks, and Archives, are supported for devices with Unmanaged status, but these devices
cannot be configured for new tasks or new archives.

In ExtremeCloud IQ - Site Engine version 23.04.11, only use ExtremeCloud
|Q to set an ExtremeCloud 1Q - Site Engine onboarded device to
Unmanaged as a temporary measure while you obtain more licenses.

If you mark a device as Unmanaged so it does not trigger a license limit
violation, you can then access ExtremeCloud |Q - Site Engine and delete

NOTE: - . L
0 the device before the license violation occurs.

You can perform an enforce for an ExtremeControl engine with an
Unmanaged status; however, if the device has an Unmanaged status, then
the enforce does not reconfigure the device and changes are not written
to the device.

When devices are marked as Unmanaged in ExtremeCloud 1Q, they are also Unmanaged in
ExtremeCloud 1Q - Site Engine.

In addition, existing ExtremeAnalytics functionality for devices with an Unmanaged status
is still supported, but only with existing configuration.

¢ Blank - Indicates the device is not successfully onboarded to ExtremeCloud 1Q from the ExtremeCloud
|Q - Site Engine because either it is already onboarded to ExtremeCloud 1Q (either from another
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X1Q Onboarded Status for Devices (Connected mode only)

ExtremeCloud IQ - Site Engine or by using the IQ Agent to connect directly), or because ExtremeCloud
|Q - Site Engine lost its connection to ExtremeCloud 1Q.

If a device's status is Blank, it has limited features available in
NOTE: ExtremeCloud 1Q - Site Engine because management of the device is
owned by ExtremeCloud Q.

e N/A - Indicates the device is not eligible to be onboarded to ExtremeCloud I1Q because it does not have
a valid serial number or MAC address, or Extreme does not yet offer onboarding support for the device.

If ExtremeCloud 1Q - Site Engine does not recognize a device’s serial
number or MAC address, right-click on the device and select Rediscover
NOTE: to attempt to discover the device’s serial number or MAC address. When
the device's serial number or MAC address is discovered, it can be
onboarded to ExtremeCloud IQ during the next onboarding cycle.

After you complete these procedures, you must return
to the next step Post Installation Procedure for Ubuntu
18.04 LTS (Bionic Beaver)ExtremeCloud 1Q - Site Engine
Suite Installation.

IMPORTANT:
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X1Q Onboarded Status for Devices (Connected mode only)

Convert from Connected to Air Gap deployment

Follow this procedure if you need to convert from Connected mode to Air Gap mode.

Delete ExtremeCloud IQ - Site Engine from ExtremeCloud 1Q

Default View
+ L /7 ®

= STATUS +  HOST MAME POLICY DEVICE LICENSE

g o XIQ-SE Pilot

In the next 48 hours, all subscriptions will be deactivated automatically. During this time

period:

¢ The ExtremeCloud IQ - Site Engine will report Connection Lost with
ExtremeCloud IQ

* New devices cannot be added to ExtremeCloud I1Q - Site Engine

Log in to ExtremeCloud I1Q - Site Engine

Go to Air Gap License Entitlements using
HTTPS://<SiteEngineIP>:8443/xiqLicenseSetup.jsp?setupMode=Airgap

Welcome to ExtremeCloud IQ - Site Engine

Back Air Gap License Entitlements

Enter the entitlement(s) for your air gapped ExtremeCloud IQ - Site Engine.
After adding entitlements to the table below, click the Continue button to log in to ExtremeCloud 1Q - Site Engine.

ExtremeCloud 1Q - Site Engine serial number (Locking 1D, UUID): XIQSE-4464725328CD4130B8D425187D41000

Don't have a license file? Generate here

Entitlements (]

Drag and drop a license entitlement file into this zone or click here to paste license entitlements.

Feature License Name Type Quantity Start Date End Date Description

PRD-XIQ-NAV-5-C XIQ-NAV-5-C Subscription 20 ;;Egﬁgi:m ;;g:ggiiﬂ ExtremeCloud IQ - Site Engine - Navigator [
PRD-XIQ-PIL-5-C XIQ-PIL-5-C Subscription Unlimited ;y&gﬁgib l“]ég;ggéi’l ExtremeCloud IQ - Site Engine - Pilot 'i'
PRD-XIQ-NACS XIQ-NAC-S Subscription 100,000 ;;ggﬁgih ;éﬁ;;ﬁgiﬁ E’;tr:tegfc“)”d 1Q - Site Engine - Access i

Displaying 3 rows

5. Copy the ExtremeCloud 1Q - Site Engine serial number (Locking ID, UUID) from the entitlements screen
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X1Q Onboarded Status for Devices (Connected mode only)

6. Generate alicense file. Follow the license generation procedure in section Air gap deployment mode:
Generate and Install the License File found in the Activation Instructions guide

7. Dragand drop the license file in the Entitlements section of the Air Gap License Entitlements screen (see
step 4).

8. Click Continue

9. Restart your ExtremeCloud 1Q - Site Engine server.

After the restart, your Site Engine is ready to use.
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X1Q Onboarded Status for Devices (Connected mode only)

Convert from Air Gap to Connected deployment

Follow this procedure if you need to convert from Air Gap mode to Connected mode.

1. Check the connectivity from ExtremeCloud IQ - Site Engine to ExtremeCloud IQ. If there is a
connectivity issue, fix it before continuing.

2. Make all of the devices managed or delete all unmanaged devices from ExtremeCloud 1Q -
Site Engine.

8

Ok NXOQ &

Davice View
Terminal
WebView
FlexView

More Views 2

Configure...
Compass Search..
Rediscover

Clear Alarms...

Upgrade Firmware...

Add to Device Group...

More Actions »
Archives »
Tasks 2
Maps k
Metwork b
Policy »

Restart Device...
Set Device Profile...
Set/Clear Frozen Ports b

Import to Site..,

Run Site's Add Actions

Contact Device Using Group's Profile
Ping Device (ICMP / TCP Echo)

Authentication Configuration...
RADIUS Configuration...
Delete Device

Overwrite Local Changes
Register Trap Receiver
Unregister Trap Receiver
Register SysLog Receiver
Unregister SysLog Receiver

Collect Davice Statistics...

Export Serial Numbers... {
Ly
—

Changs Managament Status b

Manage Device(s)

Unmanage Device(s)

3. Revoke all Air Gap licenses. For information on how to revoke the licenses, see Revoke Air Gap License.

4, GOtOHTTPS://<SiteEngineIP>:8443/xiqLicenseSetup.jsp?setupMode=Auto

5. If you do not have an ExtremeCloud I1Q account, then you need to create one.
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X1Q Onboarded Status for Devices (Connected mode only)

6. If your ExtremeCloud IQ account is not linked to your Extreme Portal account, follow the procedure in
the Activation Instructions.

7. Onboard ExtremeCloud 1Q - Site Engine to ExtremeCloud 1Q. For more information on how to onboard
Site Engine, see Logging into ExtremeCloud 1Q - Site Engine.

8. Restart your ExtremeCloud 1Q - Site Engine server.

After the restart, your Site Engine is ready to use.
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